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Chapter 1: Introduction

The Avid® EUCONTM (Extended User Control) adapter enables fully integrated control of Pro Tools® 
from EUCON-compatible control surfaces. 

In Pro Tools 10 and higher, over 500 Pro Tools commands, shortcuts, and other functions are 
EUCONized and available for Touchscreen and Soft Key assignment via EuControl software. 

Default Application Sets are installed with EuControl software, and these provide default assignments 
for you to start using immediately. You might find the default assignments ideal for your work style. 
If not, use the Soft Key Command Editor in EuControl software to customize Touchscreen buttons 
and Soft Keys to best suit your projects and workflow. 

This guide explains how to enable Artist Series controllers and use them with Pro Tools 10.0 or higher 
on supported Mac and Windows systems. 
System Requirements and Compatibility
The features described in this guide require the following: 

• Artist Series control surface

• Pro Tools or Pro Tools HD version 10.0 or higher

• EuControl software version 2.6.2 or higher

For downloads and other Artist Series resources, visit: 
www.avid.com/artistsupport

Avid can only assure compatibility and provide support for hardware and software it has tested and 
approved. For complete system requirements and a list of qualified computers, operating systems, 
hard drives, and third-party devices for Pro Tools, visit:

www.avid.com/compatibility

For setup and configuration instructions for EUCON on Pro Series systems (such as MC Pro, 
System 5-MC and System 5) see the User Guide that came with your hardware. For the latest software 
updates and information about these Avid control surfaces, visit www.avid.com/proseriessupport.
Chapter 1: Introduction 1



2

About This Guide
This guide explains how to enable EUCON and use Artist Series control surfaces with Pro Tools. 

If you are installing an Artist Series controller for the first time, start with the following resources: 

• For EuControl software and Artist Series hardware installation, see the printed documentation 
that came with your controller. 

• For complete information on your unit and EuControl software, see the electronic PDF version of 
its User Guide.

• For a list of all Pro Tools commands available in EuControl for Pro Tools 10, see the Pro Tools 
EUCON Guide. 

• For instructions on connecting and configuring Pro Tools, see the software installation and hard-
ware user guides that came with your Avid system. 

• For information about using Pro Tools software, see the Pro Tools Reference Guide (in Pro Tools, 
choose Help > Pro Tools Reference Guide).

Conventions Used in This Guide
All of our guides use the following conventions to indicate menu choices and key commands:
:

Artist Series and Pro Tools Guide
The names of Commands, Options, and Settings that appear on-screen are in a different font. The 
names of keys on Artist Series hardware are in bold (such as SEL).

The following symbols are used to highlight important information:

Convention Action

File > Save Choose Save from the File menu

Control+N Hold down the Control key and press the N key

Control-click Hold down the Control key and click the mouse button

Right-click Click with the right mouse button
User Tips are helpful hints for getting the most from your system.
Important Notices include information that could affect your data or the performance of your system.
Shortcuts show you useful keyboard or mouse shortcuts.
Cross References point to related sections in this and other Avid guides.



About www.avid.com
The Avid website (www.avid.com) is your best online source for information to help you get the most 
out of your system. The following are just a few of the services and features available. 

Product Registration Register your purchase online. 

Support and Downloads Contact Avid Customer Success (technical support); download software up-
dates and the latest online manuals; browse the Compatibility documents for system requirements; 
search the online Knowledge Base or join the worldwide Pro Tools community on the User Confer-
ence. 

Training and Education Study on your own using courses available online or find out how you can 
learn in a classroom setting at a certified Pro Tools training center. 

Products and Developers Learn about Avid products; download demo software or learn about our De-
velopment Partners and their plug-ins, applications, and hardware. 

News and Events Get the latest news from Avid or sign up for a demo.
Chapter 1: Introduction 3
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Chapter 2: Software Configuration

Before you proceed, make sure you have completed the following: 

• Installed Pro Tools or Pro Tools HD version 10.0 or higher

• Installed the latest EuControl software and attached your Artist Series hardware
Enabling EUCON in Pro Tools

To enable EUCON control in Pro Tools:

1  Make sure EuControl software is running. 

• On Mac, your desktop should have a lit EuControl icon in the upper right corner. 

For instructions for EUCON on Pro Series systems (such as MC Pro and System 5), see the User Guide 
for your system, available from our website at (www.avid.com/proseriessupport).
• On Windows, the icon appears in the System tray (or alongside other Hidden Icons if your system 
is not configured to automatically show icons in the System tray). 

 

EuControl icon
If this icon is not lit, make sure your controllers are powered on and attached. If the icon remains un-
lit, see the installation instructions that came with your Artist Series hardware.

EuControl icon in tool bar Hidden Icons (Windows)
Chapter 2: Software Configuration 5
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2  Launch Pro Tools. 

3  Choose Setup > Peripherals, and click the Ethernet Controllers tab. 

4  Select Enable EUCON. 
Artist Series and Pro Tools Guide
5  Click OK. You do not need to configure any other Ethernet Controllers settings. These settings do 
not apply to EUCON. 

Enabling EUCON in the Peripherals dialog
Pro Tools scans your system until it identifies attached EUCON-compatible hardware. When 
Pro Tools finishes scanning your system, your controllers are ready to use with Pro Tools. 

Using Multiple Units

Multiple Artist Series Units

Artist Series controllers can be combined to form larger, unified systems. For example, you can use 
two Artist Mix units and an Artist Control simultaneously. Pro Tools will recognize all attached units 
automatically. 

Using Artist Series controllers with Pro Tools version 8.x and lower utilized the HUI (MIDI Controller) 
protocol. This is no longer necessary with Pro Tools 9.0 and higher.
Other Units

When EUCON is enabled in Pro Tools, the use of additional control surfaces is subject to the following 
conditions: 

 You can use the Surround Panner Option, as well as one USB/MIDI-based control surface at the same 
time as EUCON. A MIDI control surface mirrors the first eight channels on your EUCON devices. 

 You cannot use another Ethernet-based control surface (such as an ICON worksurface or C|24 con-
trol surface) at the same time as EUCON. 

Use your EuControl software to arrange the layout of multiple units. For more information, see 
EUCON Application Setup.pdf. 



Confirm Installation

To confirm installation and communication: 

1  Make sure you have enabled EUCON as explained in “Enabling EUCON in Pro Tools” on page 5. 

2  Open a session if one is not already open. 

3  Verify the Mix window displays a blue-green border around Pro Tools tracks that are currently 
banked to your controller.
Color outlines in the Mix window showing eight Pro Tools tracks banked to Artist Mix
See the Pro Tools Installation Guide for Pro Tools optimization recommendations. 
Chapter 2: Software Configuration 7
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Chapter 3: Basics

This chapter shows you the basics of using Artist Transport, Artist Mix, and Artist Control with 
Pro Tools. Along the way you will start to become familiar with the default Application Sets for the 
Soft Keys (Artist Transport and Artist Control) and the Touchscreen (Artist Control only). 

EuControl Basics How to use EuControl software to view and customize assignments and hardware 
settings (see “EuControl Basics” on page 10). 

Do To All and Do To Selected How to use these commands so that you can apply actions to all tracks in 
a session or to all selected tracks (see “Do To All and Do To Selected” on page 18). 

Using the Transport How to use the Transport controls to play, stop, cue, record arm, and more (see 
“Using the Transport” on page 20). 

Banking the Faders How to use Bank and Nudge to be able to view tracks on the fader strips (see 
“Banking Faders” on page 22). 

Fader Controls How to adjust track volume and pan, and solo and mute tracks (see “Fader Strip Con-
trols” on page 23). 

Track Basics How to select tracks, assign input and output routing, and how to Show/Hide tracks (see 
“Track Basics” on page 25). 

Working with Track Groups How to create, modify, duplicate, and delete track groups (see “Working 
with Track Groups” on page 31). 
Chapter 3: Basics 9
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EuControl Basics
EuControl software lets you see which controllers are communicating, configure their layout (fader 
order), and customize Soft Keys and other controls. This section provides a few basic instructions 
about EuControl software. For information on each of the tabs and settings available in EuControl 
software, see the User Guide for your Artist Series controller. 

To jump directly to Pro Tools basics, see “Using the Transport” on page 20.

Viewing EuControl Settings On-Screen

To view assignments on-screen:

1  Make sure EuControl is running, then launch Pro Tools. 

2  Open the EuControl Settings window by doing the following: 

• On Mac, click the EUCON icon at the upper right of your screen and choose EuControl Settings.

• On Windows, click the EUCON icon in the System tray (or select EuControl Settings from the Start 
menu). 

3  When the EuControl Settings window appears, click the Soft Keys tab. The currently assigned Soft 
Keys are shown. 
Artist Series and Pro Tools Guide
Soft Keys tab in EuControl Settings (Artist Transport shown)
If the EuControl Settings window doesn’t look the same as the picture above, check the Section menu 
located in the upper left of the EuControl Settings window. If necessary, click it and choose Softkeys 
(choose the one with the small image of Artist Transport). 



4  To show assignments 7–12, click Shift so that it is enabled.
Viewing EuControl Settings on Artist Transport

On Artist Transport, you can use the SHOW key to view assignments on the unit. 

To view assignments on the controller display:

1  Press the SHOW key. 

2  Press any Soft Key, Transport, or numeric key on Artist Transport and its assignment is shown in the 
display. 

Customizing a Soft Key on Artist Transport
Here is a quick example of how to reconfigure one of the Soft Keys on Artist Transport. 

Soft Keys tab in EuControl Settings (Artist Transport)
To reassign a Soft Key on Artist Transport for Pro Tools:

1  Launch Pro Tools. 

2  Press the SHOW key. The EuControl Settings window opens. 

For Artist Control, see “Adding a New Touchscreen Soft Key on Artist Control” on page 14.
Chapter 3: Basics 11
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3  Click the Soft Keys tab. The currently assigned Soft Keys are shown. 
Artist Series and Pro Tools Guide
Soft Keys tab in EuControl Settings (Artist Transport shown)
4  Select the key you want to customize by clicking it on-screen, or pressing it on the controller. If you 
want to reassign a key on the second page (SHIFT layer), click Shift so that it is enabled. 

5  Click the Command button. The Soft Key Command Editor window opens showing the current as-
signment in the Details area. In this example, we selected Soft Key 6 (Scroll to Track in the default Ap-
plication Set). 

If the EuControl Settings window doesn’t look the same as the picture above, check the Section menu 
located in the upper left of the EuControl Settings window. If necessary, click it and choose Softkeys. 
You can also double-click a Soft Key to go immediately to the Command Editor. 
Soft Key Command Editor



6  To reassign the currently selected key, click a different command. For example, click Clear Clip Indi-

cators in the second (middle) list in the Details area. You can also click to make a new selection in the 
left-most Details list (such as File Menu, Edit Menu, and so on) to access other choices. 
Your assignment is now made. EuControl software retains your assignments until you Quit (Mac) or 
Exit (Windows) the EuControl application. 

You can also save, revert, or restore assignments. 

To save EuControl assignments: 

 Click the Save button in the Soft Keys tab.

To revert (undo) all assignments since the last time you saved changes: 

 Click the Revert button in the Soft Keys tab. 

To restore assignments to their factory defaults: 

 Click the Restore button in the Soft Keys tab. 

A new assignment shown in the Command Editor
Chapter 3: Basics 13
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Adding a New Touchscreen Soft Key on Artist Control
Artist Control provides a Touchscreen as well as 12 Soft Keys. 

The Touchscreen provides multiple pages, each with 24 Soft Keys in the Touchscreen. 
Artist Series and Pro Tools Guide
The 12 Soft Keys below the Touchscreen provide multiple pages of additional commands that follow 
the Touchscreen. Commands in the Soft Keys can be executed by pressing their hardware keys located 
directly below the Touchscreen, or from their Soft Key labels shown at the bottom of the Touchscreen. 

Touchscreen

SOFT KEYS

HOME

END

Soft Keys Page 
1

The following example shows how to reassign a Touchscreen button for Bounce to Disk. 

Soft Keys

A Touchscreen Soft Key for Bounce to Disk is already available in the default, factory assignments. 
This section uses Bounce to Disk as an example in case you want to reassign a key, or assign it to a pre-
viously unused Soft Key. 

SOFT KEYS

HOME

END

Soft Keys Page 
1



To reassign a Touchscreen key on Artist Control: 

1  Make sure EuControl is running, then launch Pro Tools. 

2  Open the EuControl Settings window by doing the following: 

• On Mac, click the EuControl icon at the upper right of your screen and choose EuControl Settings.
– or –
• On Windows, click the EuControl icon in the System tray (or select EuControl Settings from the 
Start menu). 

3  Click the Soft Keys tab. The currently assigned Soft Keys for page 1 (HOME) are shown. 
Soft Keys tab showing Touchscreen Page 1 for Artist Control in EuControl Settings
4  Click the Page selector and choose any page other than Page 1 (because Page 1 is the HOME page and 
provides “jump to” assignments that should not be altered). 

5  Do either of the following: 

• If you are reassigning a previously assigned key, double-click the Soft Key you want to reassign. 
The Soft Key Command Editor appears, showing the current assignment. 

If the EuControl Settings window doesn’t look like the picture above, check the Section menu in the up-
per left of the EuControl Settings window. If necessary, click it and choose Touchscreen. To reassign 
one of the 12 Soft Keys, choose Surface (choose the one with the image of Artist Control). 
– or –
• If you are assigning a key, click Add in the Command menu and choose EUCON. 
Adding a EUCON command in the Soft Key Command Editor
Chapter 3: Basics 15
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After you add a EUCON command, choices appear in the Details area. 
Artist Series and Pro Tools Guide
6  Click File Menu in the left-most list (level 1) within the Details area. The middle area of the Details 
area now shows all File Menu commands.

The Details area showing commands
An item selected in Level 1 (the first column) of the Details area



7  In the Details area, do the following:

• Click to select Bounce in the middle (level 2) Details list. Selecting Bounce reveals choices for 
Bounce to Disk and Bounce to QuickTime Movie in the third (right-most) Details list. 

– and –

• Click Bounce to Disk in the right-most list (level 3). The Command List updates to show the new 
assignment. 
8  Close the Soft Key Command Editor and return to the EuControl Settings window. 

On Artist Control, your new assignment appears in the Touchscreen. Be sure to navigate the Touch-
screen to the correct page. 

Repeat the above steps for any other Soft Keys you want to assign or reassign. 

EuControl software retains your assignments until you Quit (Mac) or Exit (Windows) the EuControl 
application. 

You can also save, revert, and restore assignments. 

To save EuControl assignments: 

 Click the Save button in the Soft Keys tab.

To revert (undo) all assignments since the last time you saved changes: 

 Click the Revert button in the Soft Keys tab. 

To restore assignments to their factory defaults: 

 Click the Restore button in the Soft Keys tab. 

Selecting Bounce to Disk command
Chapter 3: Basics 17
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Do To All and Do To Selected
Pro Tools provides the following keyboard shortcuts to let you apply actions to all or all selected 
tracks. 

To apply an action to all tracks: 

 Hold Option (Mac) or Alt (Windows) while performing the action to any track. 

To apply an action to all selected tracks: 

1  Select one or more tracks

2  Hold Option+Shift (Mac) or Alt+Shift (Win) and perform the action to any selected track. 

Do to All and Do to Selected are useful when assigning track output, assigning sends, selecting track 
Automation modes, muting, and soloing tracks. You can combine keyboard shortcuts with Artist Se-
ries hardware controls, or use the dedicated Soft Keys for Do to All and Do to Selected. 

Soft Keys for Do To All and Do To Selected
Artist Control provides Soft Keys for both Do To All and Do To Selected in its default Application Set. 
Just like Pro Tools keyboard shortcuts, these commands work on many Pro Tools actions such as as-
signing track input or output, assigning sends, setting track automation modes, muting and soloing. 
Artist Series and Pro Tools Guide
To apply an action to all tracks using Artist Control: 

1  Press the Soft Key Do To All (by default, this is in the upper row of the first set of Soft Keys directly 
below the Touchscreen). You can also press the Soft Key name at the bottom of the Touchscreen. The 
Touchscreen key lights when enabled. 

On Artist Transport, you can reassign any of its Soft Keys to provide access to these commands. 
Default Soft Key for Do To All

SOFT KEYS

HOME

END

Do To All



2  Perform the action you want to apply to all track. For example, to mute all tracks, press any lit track 
ON key. 

Do To All is not latching; it disables itself after any action. To latch this function so that it remains 
enabled, double-press the Soft Key quickly. 
To apply an action to all selected tracks using Artist Control: 

1  Select two or more tracks. For instructions, see “Selecting Tracks” on page 25. 

2  Press the Soft Key for Do To Sel. You can press the Soft Key switch, or press its name (label) shown 
along the bottom of the Touchscreen. Regardless of which method you use, the Touchscreen label 
lights when enabled. 

Be careful when putting Do to All or Do To Selected in latching mode to avoid unintended changes 
from subsequent actions to all tracks or all selected tracks.
3  Perform the action you want to apply to all track. For example, to solo all currently selected tracks, 
press any track SOLO key. 

Do To Sel is not latching; it disables itself after any action. To latch this function so that it remains 
enabled, double-press the Soft Key quickly. 

Default Soft Key for Do To Sel (Selected)

SOFT KEYS

HOME

END

Do To Sel
Be careful when putting Do to All or Do To Selected in latching mode to avoid unintended changes 
from subsequent actions to all tracks or all selected tracks.
Chapter 3: Basics 19
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Using the Transport
Transport controls Artist Series controllers provide standard Pro Tools functions such as Play, Stop, 
Rewind, Fast-Forward, Record, and others as available on each unit. 

The following figure identifies the default controls on Artist Transport and Artist Control. 

1 RTZ (Return to Zero) Returns the play cursor to the beginning of the session (Artist Transport only). 

2 Rewind Moves the play cursor earlier.

3 Fast Forward  Moves the play cursor later.

4 Stop  Stops playback.

5 Play  Starts playback.

6 Record  Toggles the Pro Tools Transport (master) record state on (armed) or off. 

7 Loop Toggles Loop Playback on and off (Artist Transport only). 

Transport controls on Artist Transport (upper left) and Artist Control (lower right)

Artist Transport

7

JOG
SHUTTLE

ZOOM HORIZ
ZOOM VERT

REC

REW

FF

STOP

PLAY

2

3

4

5
6

1

2

3

4

5

6
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Using the Transport Controls

Playback

To play from the current location: 

 Press PLAY. 

To stop playback:

 Press STOP.

Transport Controls and Modifier Keys 

You can use modifier keys on your computer keyboard in combination with EUCON hardware Trans-
port controls for additional playback modes from Artist Transport and Artist Control. 

To toggle Loop Playback on/off: 

 Press Control+PLAY (Mac), or Ctrl+PLAY (Windows). 

To toggle Pro Tools online or offline: 

 Press Option+PLAY (Mac), or Alt+PLAY (Windows).

Session Time Navigation

To jump to the beginning of the session from Artist Transport: 

 Press RTZ (return to zero). 

To rewind or fast-forward: 

 Press REW or FFW. 
Recording

To record arm the Pro Tools Transport:

 Press Record. 

Pro Tools provides preference settings for rewind and fast forward (such as Audio During Fast For-
ward/Rewind, and Back/Forward Amount). For more information, see the Pro Tools Reference Guide. 
For additional recording features, see Chapter 4, “Recording.”
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Banking Faders
To navigate to and display other tracks across the faders, use the Bank and Nudge keys. On 
Artist Control, these keys are in the Navigation section above the Transport controls. 
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On Artist Mix, Bank and Nudge are to the right of the encoder row. 

Bank and Nudge controls on Artist Control
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To bank the faders to other tracks: 

1  Press Bank>. On Artist Control, this brings the next four tracks to the faders; on Artist Mix, the next 
eight. In Pro Tools, “next” means to the right in the Mix window, and below in the Edit window. 

2  Press <Bank to move to previous tracks (to the left in the Mix window, and above in the Edit win-
dow). 

3  Press Nudge> to move one track at a time. For example, if tracks 1–8 were previously assigned to the 
faders on Artist Mix, pressing Nudge> will bring tracks 2–9 to the faders. 

4  Press <Nudge to move back one track at a time. 

If you nudge or bank beyond the first and last tracks, the display above unused track will be blank. 

HOME and Track Banking

To reset faders to the default bank on Artist Control or Artist Mix: 

 Press and hold the SHIFT key, and press <Bank (Home). 

Bank and Nudge controls on Artist Mix
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Fader Strip Controls
Fader strips on Artist Control and Artist Mix let you adjust track volume, pan, solo, and mute. 
Adjusting Track Volume and Pan
This section shows how to adjust track volume and pan with Artist Control or Artist Mix. On Artist 
Control, pan channel parameters are available through the Soft Encoders and Touchscreen. On 
Artist Mix, each channel strip provides one dual-function (rotate/push) encoder and two keys in the 
encoder row (ON and SEL).

To adjust track volume:

 Adjust the fader for that track. 

Flip mode lets you control pan, plug-ins and sends from the fader strips. See “Flipping Encoder Param-
eters to Faders on Artist Mix (Only)” on page 24. 
To reset track volume to 0/unity: 

 Hold SHIFT and touch that fader. (You can disable this in EuControl, in the Preferences tab.)

To adjust track pan: 

1  If unlit, press the PAN key so that it stays lit. 

Faders follow track volume automation, if any. You can turn faders off so they do not follow automa-
tion (or turn them back on if they have been turned off). See “Turning Faders Off” on page 75. 
2  Rotate the encoder below the name of the track you want to pan. Stereo tracks default to Left pan. 

3  To adjust right side pan on stereo tracks, press the lit Page> key and rotate the encoder for the de-
sired track. The display shows R Pan above stereo tracks and the <Page key lights. 

SOLOSOLO ON ON SOLOSOLO ON ON SOLOSOLO ON ON SOLOSOLO ON ON
Artist Control provides two dedicated Soft Encoders for left and right pan. 
Chapter 3: Basics 23



24
4  To return to left side pan, press the lit <Page key. 
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To reset pan to 0 (center):

1  If unlit, press the PAN key so that it stays lit.

2  Press the encoder below the name of the track you want to reset to center. 

SOLOSOLO ON ON SOLOSOLO ON ON SOLOSOLO ON ON SOLOSOLO ON ON
Multichannel Panning

When mixing in surround, encoders control pan parameters such as divergence, center percentage, 
and others. For more information, see “Multichannel Panning for Surround” on page 74.

Flipping Encoder Parameters to Faders on Artist Mix (Only)
Artist Mix lets you “flip” pan, plug-in, and send parameters to control them from the faders. Flipping 
plug-ins to the faders lets you control eight parameters simultaneously (or more, if your system in-
cludes more than one Artist Mix). The following example shows how to flip plug-in parameters to fad-
ers. Flip also works with pan and sends. 

To flip plug-in controls to faders using Artist Mix: 

1  Select a track that already has a plug-in inserted. 

2  Press the INSERT key. 

3  Push the encoder for the desired plug-in. 

4  On Artist Mix, press the FLIP key (hold the SHIFT key and press CHAN/FLIP). Plug-in parameters 
are now at the faders. 

5  Press the Page> key (if lit) to go to additional parameters. Press <Page to return to previous pages. 

6  Press FLIP again to flip back to encoders. 

7  Press the BACK key to close the plug-in. 

Option (Mac) or Alt (Windows) can also be used to reset Pro Tools controls. For example, holding Op-
tion (Mac) or Alt (Windows) and touching a fader resets the fader to 0/unity. 



Track Basics
This section shows how to select, route, show/hide, and group tracks. 
Selecting Tracks
You can select tracks using the fader strip SEL keys on Artist Mix and Artist Control. 

To select a track on Artist Mix or Artist Control: 

 Press any fader SEL key. 

The track is selected in Pro Tools. You can use standard Pro Tools shortcuts in combination with the 
fader SEL keys to do the following. 

To select all tracks: 

 Hold Option (Mac) or Alt (Windows) on your computer keyboard and press any unlit track SEL key. 

To deselect a track:

 Hold Command (Mac) or Start (Windows) on your computer keyboard and press a lit track SEL key.

To deselect all selected tracks:

 Hold Option key (Mac) or Alt (Windows) on your computer keyboard and press any lit track SEL 
key. 

To select a range of tracks:

1  Press the SEL key on the first track (usually, the left-most track you want to include in the selec-
tion). 

2  Hold the Shift key on your computer keyboard and press the SEL key on the last (right-most) track. 
All tracks between the two are selected. 

To select non-adjacent tracks (add to a selection): 

1  Press the SEL key to select any track. 

2  Hold Command (Mac) or Start (Windows) on your computer keyboard and press an unlit track SEL 
key.

You can also add new tracks to your sessions using default Soft Keys on Artist Control (a New 
Tracks key is provided in the default HOME page (page 1), or by reassigning Soft Keys on Artist 
Transport. 
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Track Input and Output Routing

Routing Track Input and Output on Artist Control

These examples show how to assign track input and output from the Soft Keys and Touchscreen sec-
tions on Artist Control. 

To assign track input on Artist Control: 

1  Select a channel by pressing its SEL key. 

2  Press the Input Encoder. 
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The Touchscreen shows the input assignment for the currently selected next to Encoder 8.

SOFT KEYS

HOME

END

Input
3  Press Encoder 8 (the one showing no input, or the current input assignment, if any). 

Soft Encoder for current input assignment. 

SOFT KEYS

HOME

END

no input



4  The first three Soft Encoders now display no input, interface, and bus. 

5  Press Soft Encoder 1, 2, or 3 to select the following as desired: 

no input (encoder 1) Assign no input source to the track. 

hardware (encoder 2) Displays available hardware input choices on the Soft Encoders. 

bus (encoder 3)  Displays available internal bus choices on the Soft Encoders. 

Artist Control shows up to eight available hardware input or bus choices at a time (one in each Soft 
Encoder). You can navigate to additional hardware or bus choices by pressing <Page or PAGE>.

6  When the desired input source is displayed, press its Encoder. 

7  To exit Input Assign mode, press BACK (each press returns you up one level), or press 
SHIFT + BACK/TOP to exit and return to the top Soft Keys level.

To assign track output on Artist Control:

1  Select a channel by pressing its SEL key. 

2  In the Soft Encoders, press the Mix Encoder. If it is not shown, press BACK until is appears. 
The Touchscreen shows the output assignment for the currently selected track next to Encoder 1.

3  Press Encoder 1 (the one showing the current assignment, if any). The first three Soft Encoders now 
display the next level of choices for output assignment. 

4  Press Soft Encoder 1, 2, or 3 to select the following as desired: 

no output (encoder 1) Assigns no output to the track (the track will be silent).

hardware (encoder 2) Displays Output bus choices (such as Out 1–2) in the Soft Encoders. 

bus (encoder 3)  Displays internal bus choices in the Soft Encoders. 

Soft Encoder for Mix

SOFT KEYS

HOME

END

Mix
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5  To see additional choices, press the lit <Page or Page> key.

6  When the desired output choice is displayed, press its Encoder. A green LED lights next to the Soft 
Encoder, indicating assignment on the currently selected track(s). 

7  To exit Output Assign mode, press BACK (each press returns you up one level), or press 
SHIFT+BACK/TOP to jump back to the top view.

Multiple Output Path Assignments

Pro Tools tracks can have multiple output paths assigned to them. When assigning track output from 
a EUCON unit, you can simply repeat the previous instructions and the new assignment will be added 
to the current assignments. When reassigning outputs, you must first assign no output, then assign the 
new output path. 

To reassign track output without adding additional output assignments on Artist Control: 

1  Select a channel by pressing its SEL key. 

2  In the Encoders, press the Mix encoder. The Touchscreen shows the output assignment for the cur-
rently selected track.

3  Press Encoder 1 (the one showing the current assignment, if any). The first three Encoders now dis-
play the next level of choices for output assignment. 

4  Press Soft Encoder 1 to select no output. 

5  Press BACK (each press returns you up one level), or press SHIFT+BACK/TOP to jump back to the 
top view.

6  Repeat these steps and choose a new output path. 
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Routing Track Input and Output on Artist Mix

These examples show how to route track input and output from Artist Mix. 

To assign track input on Artist Mix:

1  Select a channel by pressing its SEL key. 

2  Press SHIFT+INSERTS/INPUT.  The display shows input assignments for banked tracks. 

3  Press the Encoder for the track you want to assign. The first three Soft Encoders show the next 
choices for input assignment.

4  Press the Soft Encoder below the desired input choice: 
• If you select no input, that encoder ON key lights. 

• If you select interface or bus, available hardware inputs or internal busses are listed above the Soft 
Encoders. Press the <Page and/or Page> keys to navigate to other input choices.

5  When the desired input source is displayed, press its Soft Encoder. The encoder ON key lights. 

6  To exit output assign mode, press PAN.

To assign track output on Artist Mix:

1  Select a channel by pressing its SEL key. 

2  Press SHIFT+PAN/MIX.  The display shows the output assignment for each banked track.

3  Press the encoder for the track you want to assign. 

4  Press the encoder below the desired output assignment as follows: 

Display no input interface bus

Soft Encoder  1  2  3
• If you select no output, the assignment is made and that encoder ON key lights. 

• If you select output or bus, Output bus and internal bus choices are listed above each Soft Encoder. 
Press the < PAGE and/or Page> keys to navigate to other output choices.

5  When the desired output is displayed, press its Soft Encoder. That encoder ON key lights.

6  To exit output assign mode, press any other Knob Set selector (such as PAN).

Display no output output bus

Soft Encoder 1 2 3
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Multiple Output Path Assignments

Pro Tools tracks can have multiple output paths assigned to them. When assigning track output from 
a EUCON unit, repeat the previous instructions and the new assignment will be added to the current 
assignments. When reassigning, you must first assign no output, then assign a new output path. 

To reassign track output on Artist Mix: 

1  Select a channel by pressing its SEL key. 

2  Press SHIFT+PAN/MIX. The display shows the output assignment for each banked track.

3  Press the encoder for the track you want to assign. 

4  Press the encoder for no output (encoder 1). The assignment is made and that encoder ON key lights. 

5  To exit output assign mode, press any other Knob Set selector (such as PAN).

6  Repeat these steps and assign the new output path. 

Showing and Hiding Tracks
Artist Control lets you show and hide tracks using the Touchscreen. 
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To Show or Hide tracks: 

1  Select one or more tracks by pressing the track SEL keys (see “Selecting Tracks” on page 25 for in-
structions on selecting multiple tracks). 

2  In the Touchscreen, go to Page 1 (the Home page) and press SHOW/HIDE TRACKS. The Touchscreen 
displays a page of controls specific to showing and hiding tracks. 

3  Do any of the following: 

• To hide all selected tracks, press Hide Selected Tracks.

• To show (restore) all selected tracks, press Show Selected Tracks. 

• To hide all tracks in the session, press Hide All Tracks. 

• To show (restore) all tracks in the session, press Show All Tracks. 

The Touchscreen Show/Hide page provides many other useful actions for showing and hiding specific 
types of tracks (such as Show Audio Tracks and Show Aux Tracks), as well as commands for inactive 
tracks (such as Show Inactive Tracks and Hide and Make Inactive. 

On Artist Transport, you can reassign one of the 12 Soft Keys for Show/Hide track commands. 



Scroll to Track

Scroll to Track is a fast way to bring a specific track on-screen (this is useful in large sessions with 
many tracks).

To use Scroll to Track: 

1  In the Touchscreen go to Page 1 (the Home page) and press SHOW/HIDE TRACKS. 

2  Press Scroll to Track. The Touchscreen displays the Scroll to Track panel, with keys replicating the 
numeric keypad. (On-screen, the Scroll to Track dialog is displayed). 

3  Use the Touchscreen keys to enter a track number. 

4  Press OK. 

The Mix and Edit windows scroll so that the desired track is displayed on-screen. 

Working with Track Groups
This section shows how you can work with Pro Tools track Groups using an Artist Control or 
Artist Mix. 

Working with Track Groups on Artist Control

To create a new Group: 

1  Select the tracks you want to include in the new Group by doing the following: 

• Press and hold SEL on the first track you want in the Group. 

• Press SEL on the other tracks you want to select (while still holding SEL on the first track). 

2  In the Touchscreen, press SOFT KEYS to show the Soft Keys. 

3  If Page 1 (HOME) is not already displayed, navigate to Page 1 of the Touchscreen by doing either of 
the following: 

• On the current page, press the Soft Key labelled HOME (if available) or BACK and then HOME.

• Use the Page Up (arrow) Soft Key until Page 1 is displayed. 
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4  On Page 1, press the Soft Key GRP EDIT. 
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The Touchscreen shows Soft Keys specific to working with Groups. 

5  To create a group of the currently selected tracks, do any of the following: 

• To create a Mix/Edit Group, press the key MIX/EDIT GROUP.

• To create an Edit Group, press EDIT GROUP. 

• To create a Mix Group, press MIX GROUP. 

On-screen, the Pro Tools Create Group dialog appears. 

6  Configure the Create Group dialog as desired. For more information on Tracks, Attributes, Globals, 
and other Group settings, see the Pro Tools Reference Guide. 

7  To confirm the new group, click OK on-screen, or press Enter on your computer keyboard.

To add or remove tracks from a Group: 

1  Select a channel by pressing its SEL key. 

2  Press the GROUP encoder to enter Group mode.  

Touchscreen HOME page 
Soft Encoder for Group

SOFT KEYS

HOME

END

Group



Existing Group names are listed in the Soft Encoders, starting with the <All> Group in encoder 1. 
Green LEDs next to Soft Encoders indicate Group membership for the currently selected track. 

3  Press the Soft Encoder for a Group to add the current track to it (the green LED is lit), or remove the 
track from the group (no green LED). 

To enable or suspend a Group using the Soft Encoders:

1  Press the GROUP encoder to enter Group mode. Group names fill as many Soft Encoders as neces-
sary. Green LEDs in the Touchscreen encoders indicate group membership for the currently selected 
track. 
2  Hold SHIFT and press the Touchscreen encoder for a group to toggle it between enabled and sus-
pended. 

To enable or suspend a Group using the Touchscreen: 

1  Navigate to Page 1 of the Touchscreen Soft Keys. This example assumes you are using the default Soft 
Key assignments; if you have customized your Soft Keys the exact page or other steps may differ. 

2  In the Touchscreen, press GRP EDIT. The Touchscreen displays Soft Keys for each Group across the 
top row (such as |:<ALL>, a:Group1, b:Group2, and so on). These appear on the Touchscreen regardless 
of how many Groups you have created in the current session). To navigate to other Groups, press the 
appropriate key in the bottom row (such as ALL–11, or 12–23). 

3  Press the Touchscreen key for any Group to toggle it between enabled and suspended. When enabled, 
the Soft Key for that Group is lit; when suspended, the Soft Key is dark. For example, to toggle Group 
1 on/off, press the Soft Key a:GROUP1. 

To rename or edit a Group: 

1  On Page 1 of the Touchscreen, press GRP EDIT. The Touchscreen displays a page of Soft Keys specific 
to working with Groups. 

Soft Encoder for Group

SOFT KEYS

HOME

END

Group
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2  In this page of the Touchscreen, do each of the following: 

• Press MODIFY GROUP. The button flashes.

• In the top two rows of the Touchscreen, press the button for the Group you want to modify (such 
as c:Group 3). If you have renamed a Group, its name is displayed along with its letter designation 
(such as 3: DRUMS). To navigate to other Groups, press the appropriate button in the bottom row 
(such as ALL–11, or 12–23). 

3  On-screen, the Modify Groups dialog appears. Use the mouse to configure the settings for Tracks, 
Attributes, and Globals as desired. 

4  To confirm your changes, do one of the following: 

5  On Artist Control, press the Soft Key OK key (or press Enter on your computer keyboard). To close 
the dialog without changing Group settings, press the Cancel Soft Key (or click Cancel on-screen). 

To duplicate or delete a Group: 

1  On Page 1 of the Touchscreen, press GRP EDIT. The Touchscreen shows displays a page of Soft Keys 
specific to working with Groups. 

2  Do either of the following: 

• If you want to duplicate a Group, press DUPLICATE GROUP (the button flashes).

• If you want to delete a Group, press DELETE GROUP (the button flashes). 

3  In the top two rows of the Touchscreen, press the button for the Group you want to duplicate or de-
lete (such as c:Group 3). If you have renamed a Group, its name is displayed along with its letter des-
ignation (such as 3: DRUMS). To navigate to other Groups, press the appropriate button in the bottom 
row (such as ALL–11, or 12–23). 

4  Do either of the following, as appropriate: 

• If you are duplicating a Group, the Create Group dialog appears on-screen. Configure the settings 
for the new Group as desired, then press the OK Soft Key to confirm (or press the Enter key on 
your computer keyboard, or click OK on-screen). To cancel, press the Cancel Soft Key (or click 
Cancel on-screen). 

• If you are deleting a Group, a confirmation dialog appears on-screen (deleting a Group cannot be 
undone). To confirm, press the OK Soft Key (or press Enter on your computer keyboard). To can-
cel, click the Cancel Soft Key (or click Cancel on-screen). 
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Group Spill

Group Spill lets you quickly bring all tracks in a particular group to the faders. 
To spill a group: 

1  On Page 1 (HOME) of the Touchscreen, press GRP SPILL. 

2  Press SHOW TRACKS IN GROUP (the Soft Key lights to indicate it is active), then press the button 
for any group shown in the top rows (such as a:Group1). All other tracks in the session are hidden and 
the members of the selected group appear on the faders. 

To return to showing all tracks from the GRP SPILL page:

 Press SHOW TRACKS IN GROUP, then press !:<ALL>. 

Before using Group Spill, it is recommended that you create a Pro Tools Memory Location (Marker) 
and configure it to store and recall Track Show/Hide status, so you can quickly return to the previous 
view (unspill). You can create and recall Memory Locations from Artist Control (see “Using Markers 
(Memory Locations)” on page 46). To learn how to configure the Pro Tools Memory Locations window, 
see the Pro Tools Reference Guide. 
Other Soft Keys in the GRP SPILL page let you hide or select tracks by group, or suspend all groups. 

You can also press SHOW/HIDE TRACKS for more flexibility as to which tracks you want to show and 
hide. For a few examples of how to use these commands, see “Showing and Hiding Tracks” on page 30. 
Working with Track Groups on Artist Mix

To enable or suspend a track Group using Artist Mix:

1  Press SHIFT+AUX/GROUP. The display shows <All> in every fader display (or, the letter designation 
of the last edited group). 

2  Press the lit Page> keys to show other available Groups across the display. As you navigate to other 
Groups, the encoder SEL keys (in the encoder row) light to indicate an active (enabled) Group. In ad-
dition, track ON keys light to indicate track membership in the currently displayed Group. 

3  To enable a Group, press any unlit (encoder) SEL key so that it stays lit. 

4  To suspend a Group, press any lit (encoder) SEL key. 

On Pro Tools HD or Pro Tools with Complete Production Toolkit, you can assign groups to VCAs and 
then view group members through the VCA track. For more information, see “Viewing Groups in VCA 
Masters” on page 71. 
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To add or remove tracks from a Group using Artist Mix: 

1  Press SHIFT+AUX/GROUP. The display shows <All> above each encoder (or the letter designation of 
the last edited group). All tracks are members of the <All> group by default. 

2  Press the lit PAGE> keys to show other available Groups across the display. As you navigate to other 
Groups, track ON keys light to indicate track membership in the currently displayed Group. 

3  To add a track to the currently displayed Group, press the encoder in the desired track (below the 
displayed Group name). The track ON key lights green showing that track is now a member of the 
Group.  

4  To remove a track from a Group, press the encoder again so that the ON key in that track is unlit. 
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On Pro Tools HD or Pro Tools with Complete Production Toolkit, you can assign groups to VCAs and 
then view group members through the VCA track on Artist Mix. For more information, see “Viewing 
Groups in VCA Masters” on page 71. 



Chapter 4: Recording

This chapter explains how you can perform many Pro Tools recording tasks from Artist Series units. 

Select and Record Enable Tracks 
This section explains how to use track and deck record enable commands. 

To record enable a track: 

 Press the track REC key. 

To record enable additional tracks: 

 Hold the Shift key on your computer keyboard and press additional track REC keys. 
To record enable all tracks or all selected tracks on Artist Control: 

1  Press the Soft Key Do To All or Do to Sel (in the Touchscreen, the key lights).

2  Press any track REC key. 

To record enable all tracks or all selected on Artist Mix: 

 Hold Option (Mac) or Alt (Windows) on your computer keyboard (to do to all) or Option+Shift 
(Mac) or Alt+Shift (Windows), then press a track REC key. 

To arm the Pro Tools Transport (deck) from Artist Control: 

 Press the Record key in the Transport section. Or from the Touchscreen HOME page (Page 1), press 
TRANS > RECORD, then press Master Record. 

To arm the Pro Tools Transport (deck) from Artist Transport: 

 Press the Record key in the Transport section. 

You can set Pro Tools Preferences for latching record enable, so you don’t have to hold the Shift key to 
record enable additional tracks. For more information, see the Pro Tools Reference Guide.
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Loop Record, Quick Punch, and Other Record Modes
Artist Transport and Artist Control can access all available Pro Tools recording modes. You can use 
keyboard modifiers in combination with the Transport buttons, or use Soft Keys. 

Commands are also available in EuControl software to let you cycle through available modes. Some of 
the features are only available on Pro Tools HD or Pro Tools with Complete Production Toolkit. 

To cycle to the next alternate Record modes using the Transport REC key on Artist Transport and 
Artist Control:

 Hold Control (Mac) or Ctrl (Windows) on your computer keyboard and press the REC key (for ex-
ample, on Artist Control, press the REC key in the Transport section). On-screen, the Pro Tools Trans-
port master Record switch shows the current mode (P indicates QuickPunch, a Loop arrow appears 
when in Loop Record mode, and so on). 

To cycle to the next available alternate Record modes using the Touchscreen on Artist Control: 

1  In the Touchscreen, go to Page 1 (HOME) and press TRANS. 

2  In the Touchscreen page that appears, press NEXT RECORD MODE. 

Artist Control also provides dedicated Touchscreen keys for enabling special Pro Tools recording 
modes. 

To enable a specific Record mode using the Touchscreen on Artist Control: 

1  In the Touchscreen go to Page 1 and press MENU. This displays the MENU page which shows all the 
main Pro Tools menus. 

2  In the MENU page, press OPTIONS.

3  Press the Touchscreen key for the desired Record mode (such as Destructive Record or QuickPunch).

TrackPunch
(Pro Tools HD or Pro Tools with Complete Production Toolkit Only)

Artist Control provides default keys for TrackPunch mode. 
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To enable TrackPunch mode: 

 From Page 1 of the Touchscreen, press MENU > OPTIONS > TrackPunch. 

To exit TrackPunch mode: 

 Press TrackPunch again. 

On Artist Transport, you can reassign one of the 12 Soft Keys for TrackPunch in EuControl. 



DestructivePunch
(Pro Tools HD or Pro Tools with Complete Production Toolkit Only)

Artist Control provides default keys for DestructivePunch. 
To prepare tracks for DestructivePunch: 

1  From Page 1 of the Touchscreen, press MENU > OPTIONS > DestructivePunch. 

2  Record enable the tracks you want to punch by pressing their track REC switches. 

3  In the Touchscreen, press Prepare DPE Tracks. 

To enable DestructivePunch mode (Pro Tools HD only): 

 From Page 1 of the Touchscreen, press MENU > OPTIONS > DestructivePunch. 

To exit TrackPunch mode

 Press DestructivePunch again. 

You can access the Prepare DPE Tracks command from this same page. 

Additional Recording Features
Artist Control give you direct access to many additional controls related to recording. Not all features 
are available on all systems (some require Pro Tools HD or Pro Tools with Complete Production 
Toolkit). 

On Artist Transport, you can reassign one of the 12 Soft Keys for DestructivePunch in EuControl. 
To access additional recording commands on Artist Control: 

 From Page 1 of the Touchscreen, press the TRANS key. 

The default buttons assigned on this page include Count Off, Wait for Note, Click, MIDI Merge, Next 
Record Mode, Pre-Roll and Post-Roll, and keys for Master Record (Transport Record) and Master In-
put Monitor (to be able to switch all record enabled tracks to Input Only). 

Buttons along the bottom of the page take you to sub-pages with the following commands and features 
for recording, location, and other tasks. 

PLAY (HOME > TRANS > PLAY) Provides buttons for Pause, Play/Stop, Count Off, Dynamic Transport, 
Half-Speed Play, and others. Press the TRANS key to return to the previous page. 

On Artist Transport, you can reassign its Soft Keys for any of the available recording commands de-
scribed below. 
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RECORD (HOME > TRANS > RECORD) Provides many of the same buttons as the TRANS page, plus 
buttons for Half-Speed Record, Loop Record, Abort Record, Pre-Fader Metering, Record Arm Tracks 
with Selection, Input Monitor Tracks with Selection, and Low Latency Monitoring. Press the TRANS 
button to return to the previous page. 

LOCATE (HOME > TRANS > LOCATE) Provides navigation and locate commands including Go to Song 
Start, Go to End of Session, Prev, Next, and Enable Tab to Transients. Press the TRANS button to re-
turn to the previous page. 

MACH CTL (HOME > TRANS > MACH CTL) Provides Machine Control commands including Toggle 
Transport Master, 9-Pin Remote, Auto Ins Punch, Ins Assem (Insert Assembly), as well as keys for 
Video Track Online, Video Out Firewire, and Video Out PCIe. Press the TRANS button to return to the 
previous page. 

SATELLITE (HOME > TRANS > SATELLITE) Provides selectors for each Satellite system (up to 12). 
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Chapter 5: Editing

This chapter explains how you can perform many Pro Tools editing tasks from Artist Control and Art-
ist Transport. It would be impossible to describe every Pro Tools editing feature in this guide, so in-
stead we have chosen to highlight a few of the most frequently used commands. Before proceeding, 
read the following overview so you can start to become familiar with how the default assignments are 
organized. 

Overview of Editing
Artist Control and Artist Transport provide programmable Soft Keys that can be assigned to any 
available Pro Tools commands in EuControl software. 

• Artist Control provides dozens of editing commands in its default Application Set for Pro Tools. 
These are provided in a series of dedicated Touchscreen and Soft Key pages that can be accessed 
with a few presses, and include nearly all commands found in the Pro Tools Edit and Clip menus.

• On Artist Transport, you can use EuControl software to customize the assignment of the Soft 
Keys and Jog/Shuttle Ring for any of the tasks described here. 

To access editing features on Artist Control: 

 From Page 1 (HOME) of the Touchscreen, press EDITING. The Touchscreen shows the first page of 
editing commands. (Pages and buttons on your system may differ from the image shown.) 
The default Application Set for Pro Tools has been designed to provide fast access to the most com-
mon functions, with additional pages available to access additional functions. 
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The primary Editing page includes the following commands and functions in the upper rows of its de-
fault (factory) Touchscreen assignments. 

• Group and Ungroup Clips

• Loop and Unloop Clips

• Duplicate, Repeat, Consolidate Clip, Heal Separation

• Restore Last Selection

• Identify/Remove Sync Point

• Edit Lock/Unlock

• Trim Lock/Unlock

• Mute/Unmute Clip

• Zoom Toggle

• Trim Top and Trim Tail

Additional buttons are provided in the bottom row of the Touchscreen to take you to more editing 
commands. 

EDITING 2 Provides buttons for Grid and Nudge value, Link Timeline/Edit Selection, Link Track/Edit 
Selection, Separate Clip on Grid or on Transients, and more. Press the EDITING button to return to 
the previous page. 

SELECT Provides buttons for Move Selection Up/Down, Extend Selection Up/Down, Nudge Selection, 
and other commands related to selections. Press the EDITING button to return to the previous page.

FADES/TRIM  Provides Fade to Start, Fade to End and other commands for fades, as well as Trim Clip 
commands (such as To Selection, Start to Insertion, and End to Insertion). Press the EDITING button 
to return to the previous page. 

Wheel  Provides commands to let you use the Jog/Shuttle wheel for basic Jog and Shuttle as well as 
horizontal and vertical scrolling, Mark In and Mark Out, zooming, and moving selections. Press the 
EDITING button to return to the previous page. 
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Counter  Provides Main and Sub Counter mode selectors, as well as buttons to select time base (such 
as Bars|Beats or Minutes:Seconds). Press the EDITING button to return to the previous page.

In addition, the 12 Soft Keys below the Touchscreen follow the Touchscreen and provide access to 
functions such as Undo, Cut, Copy, Paste, and Separate. 

For more info on using the Jog/Shuttle wheel see “Using the Jog/Shuttle Wheel” on page 44. 



Selecting Edit Tools and Edit Modes
One of the most frequent tasks in Pro Tools is selecting different Edit Tools (such as the Grabber, Se-
lector, Trimmer and their variants) and Edit Modes such as Slip mode and Grid modes. This section 
shows how you can use the Soft Keys on Artist Control to access Edit Tools and modes. 
To access Edit Tools and Modes in the Touchscreen: 

 In Page 1 (HOME) of the Touchscreen, press TOOLS. The default TOOLS page provides buttons for 
each Edit Mode, Edit Tool and variants, zoooming and more. 

To change Edit Tools using the Soft Keys: 

1  Press SHIFT +SOFTKEYS/HOME to return the Soft Keys to their first (home) page. 

On Artist Transport, you can reassign any of its 12 Soft Keys to provide access to Edit commands. 
2  Press the SOFT KEYS V (down) key once to navigate the Soft Keys to the second page. 

Soft Keys Home Up/Home

SOFT KEYS

HOME

END
3  Press the Soft Key for the desired Edit Tool (such as the Trim, Selector, or Grabber). You can press the 
buttons in the bottom of the Touchscreen, or their corresponding Soft Key. 

4  Press an Edit Tool Soft Key again to select the next option for that tool. For example, pressing Trim 
repeatedly cycles through all available Trim tool options. If it does not, see “Edit/Tool Mode Lock” on 
page 44. 

To select the Smart Tool: 

 Press the Soft Keys for any two of the Edit Tools Trim, Selector, or Grabber simultaneously. 

Soft Keys V (Down)

SOFT KEYS

HOME

END
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To change Edit Modes using the Soft Keys: 

1  Press SHIFT +SOFTKEYS/HOME to return the Soft Keys to their first (home) page. 

2  Press the SOFT KEYS V (down) key once to navigate the Soft Keys to the second page. The Soft Keys 
display now shows Edit Modes in the upper row. 

3  Press the Soft Key for the desired Edit Mode (Shuffle, Slip, Spot, or Grid). To toggle between Absolute 
and Relative Grid mode, press the Grid Soft Key again. In Pro Tools, the Edit Mode display shows Rel 

Grid when that mode is enabled. 

Edit/Tool Mode Lock
Edit/Tool Mode Keyboard Lock lets you  lock the currently selected Edit Tools (Zoom, Trim, Grabber, 
and Pencil only) in place and prevent them from being inadvertently changed to one of their other 
variants (such as Zoom changing from Normal Zoom to Simple Zoom). 

To lock (or unlock) the current Edit Tool modes:

1  Press SHIFT +SOFTKEYS/HOME to return the Soft Keys to their first (home) page. 

2  Press the SOFT KEYS V (down) key once to navigate the Soft Keys to the second page. 

3  Press the Soft Key for Edit/Tool Mode Lock. 

Using the Jog/Shuttle Wheel
The Jog wheel on Artist Control and Shuttle ring on Artist Transport can perform a variety of func-
tions such as basic Jog and Shuttle, zooming, and adjusting track height. You can also use it to adjust 
clip gain (see “Clip Gain” on page 51). 

Jog and Shuttle

To use the Jog wheel to jog and shuttle:

1  Enable Jog mode by pressing the JOG key (if available) or the Soft Key assigned to Jog. 

2  Rotate the Jog wheel to jog back or forward. 

3  To enable Shuttle mode, press the SHUTTLE key or the equivalent Soft Key, if available.

4  To exit Jog or Shuttle mode, press STOP. 
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Zoom Horizontally

To zoom horizontally: 

1  Press the ZOOM HORIZONTAL key, or assign a key to Zoom Horizontal using EuControl software. 

2  Spin the Jog wheel to the left to zoom out horizontally (show more session time), or to the right to 
zoom in. 

Zoom Verticaly (Adjust Track Height)

To adjust track height (zoom vertically):

1  Place the cursor in the tracks you want to adjust. 

2  Press the ZOOM VERTICAL key (on Artist Control, press SHIFT+ZOOM HORIZ), or assign a key to 
it using EuControl software. 

3  Spin the Jog wheel to the left to zoom out (reduce track height), or to the right to zoom in and in-
crease track height. 

Marking and Moving Selections

To use the wheel for Mark In and Mark Out: 

1  From Page 1 of the Touchscreen, press EDITING > WHEEL. 

2  Begin playback (press PLAY in the Transport). 

3  At the desired selection start point, press the Mark In button in the Touchscreen. 

4  At the desired selection end, press Mark Out. 

5  Press STOP. 

To use the wheel to move a selection: 

1  Make a selection within a track. 

2  From Page 1 of the Touchscreen, press EDITING > SELECT. 

3  Use any of the available Touchscreen buttons as desired. Choices include common selection com-
mands such as Move Selection Up/Down, Extend Selection Up/Down, Nudge Selection Start For-
ward/Back, and more. 
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Using Markers (Memory Locations)
Pro Tools Markers let you store and navigate to specific locations in your session (such as to mark the 
beginning of a verse, or the beginning of dialog). They also let you navigate to selections in the time-
line (such as an entire verse, or complete scene), store and recall track height and show/hide status, 
and more. 

Any controller with a numeric keypad such as the Artist Transport can create and recall (go to) Mem-
ory Locations. Artist Control provides Touchscreen pages for creating, recalling, and managing 
Markers as well as Window Configurations. 

Using Markers on Artist Transport

To create a Marker in a Pro Tools session using Artist Transport: 

1  Begin playback. 

2  At the point where you want to store a marker, press the Enter key on the numeric keypad. 
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To recall a Marker using Artist Transport:

 On the Artist Transport numeric keypad, press Decimal (.), the Memory Location number, and Dec-
imal (.) again.

Enter key on the numeric keypad

Artist Transport



Using Markers on Artist Control

To create a Marker in Pro Tools with Artist Control: 

1  Navigate the Touchscreen to Page 1 (HOME), then press MEM LOC to go to the Memory Loca-
tions/Markers page. 

2  Begin Pro Tools playback, or place the Edit cursor at the desired location in the session. 

3  When playback reaches the desired location, press CREATE in the Touchscreen. 
4  On-screen, configure the New Memory Location dialog as desired. (For information on the options 
available in this dialog, see the Pro Tools Reference Guide.) 

5  Press the OK Soft Key (below the Touchscreen). Or press Cancel to cancel the new marker. 

To recall a Marker using Artist Control: 

1  From the Touchscreen Page 1 (HOME) press MEM LOC. The default assignments for this page list the 
first 12 markers across the top two rows of Soft Keys. The bottom row of Touchscreen Soft Keys navi-
gate to additional markers (1–12, 13–24, and so on). 

2  Press a Touchscreen button to recall that Marker/memory location (such as <MemLoc1>). 

3  To access other memory locations, press the appropriate button along the bottom row of the (de-
fault) Touchscreen. For example, to recall Marker 32, press the key 25–36, then press <Mem Loc32>. 

To edit a Marker using Artist Control: 

1  From the Touchscreen Page 1 (HOME) press MEM LOC. 

2  Press EDIT (the key starts to flash). 

3  Press the Touchscreen key for the marker you want to edit (such as <Mem Loc1>). 

4  On-screen, configure the Edit Memory Location window as desired. 

5  Press the OK Soft Key to confirm your changes (or press Cancel to cancel). 
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To delete a Marker using Artist Control: 
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1  From the Touchscreen Page 1 (HOME) press MEM LOC. 

2  Press DELETE (the button starts to flash). 

3  Press the Touchscreen button for the marker you want to delete (such as <Mem Loc1>). 

Working with Windows and Window Configurations

Toggle Mix and Edit Windows

Artist Control and Artist Mix let you toggle between the Pro Tools Mix and Edit windows. 

To toggle Mix and Edit window views from Artist Control: 

 From the Touchscreen Page 1 (HOME) press Mix/Edit Window Toggle. 

To toggle Mix and Edit window views from Artist Mix: 

 Press SHIFT+<NUDGE/Mixer.

Window Configurations

In Pro Tools, Window Configurations let you store and recall arrangements of windows on-screen. 

To store a Window Configuration: 

1  Open and arrange Pro Tools windows as desired. 

2  From the Touchscreen Page 1 (HOME) press WINDOW. 

3  In the WINDOW page, press NEW WIN CONFIG. 

4  Configure the on-screen New Window Configuration dialog as desired. 

5  Press the OK Soft Key (or click OK on-screen). 

To recall a Window Configuration: 

1  From the Touchscreen Page 1 (HOME) press WINDOW. The top two rows of Soft Keys list the first 12 
Window Configurations in the current session. 

2  Press the Soft Key for the desired Window Configuration. To navigate to other stored Window Con-
figurations, use the Soft Keys in the bottom row (such as 13–34). 

Be careful when deleting Markers. There is no confirmation dialog or opportunity to cancel; once you 
select a marker to delete, it is deleted. 



Other keys in the default WINDOW page let you edit, clear, and update Window Configurations, as 
well to control Auto Update. For more information on these features, see the Pro Tools Reference 
Guide. 

Recalling Layouts
EuControl software lets you store and recall assignments of specific tracks as Layouts. Layouts let you 
assign specific tracks to specific faders, and have those fader strips ignore banking and nudging (en-
suring that the specific tracks remain available for as long as the Layout is active). 

Artist Control provides a page of Touchscreen Soft Keys for selecting and recalling Layouts. Storing 
Layouts requires a combination of Soft Keys and on-screen configuration of the EuControl Assign and 
Layouts tabs. Once stored, Layouts can be recalled directly from Artist Control. 
To store a Layout with Artist Control: 

1  In Touchscreen Page 1 (HOME) press LAYOUTS.

2  Press a Soft Key in the upper part of the Touchscreen to select an unused Layout (such as 
LAYOUT 1). 

3  Open the EuControl Settings window and click the Assign tab. (See “Viewing EuControl Settings On-
Screen” on page 10.)

4  Before creating a custom Layout, we recommend saving one “home” Layout so you can quickly re-
turn fader strips to standard banking. To do so: 

• Make sure all strips say <auto assigned> in the Assigned To column. If any are not, click the dis-
played name in the Assigned To column and choose <auto assigned>. 

• Use the mouse to go to the Layouts tab, click to select row (Layout Name) “1” and click Store. 

• Give the new Layout a descriptive name such as “All” or “Home” so you can easily recognize it. To 
do so, click in the Name column for the desired Layout until you can edit the default name, then 
enter a new name and press the Enter key on your computer keyboard. 

5  Use the mouse to return to the Assign tab. 

6  Use the mouse to configure the Assign tab by clicking in the Assigned To column for each strip and 
selecting a track to assign (lock) to that fader strip. Repeat for each available strip (on Artist Control 
there are four available fader strips; if your system also includes an Artist Mix, you will see more avail-
able fader strips in the Assign tab). 

7  Use the mouse to go back to the Layouts tab. 

8  In the Layouts tab, click to select an available Layout (such as 2). 

For more information about the Assign and Layouts tabs in EuControl software, see the User Guide 
that came with your Artist Series controller.
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9  Use the mouse to click Store. 

10  By default, Layouts are named according to the date and time they were stored. If you want to re-
name the Layout for easier recognition, click its name in the list and enter a new name. For example, 
if you assigned (locked) a Master Fader or VCA to a fader strip, you might want to name its Layout 
“MASTER on 4” or similar. 

To recall a Layout from Artist Control: 

1  From the Touchscreen Page 1 (HOME) press LAYOUTS. 

2  Press a Soft Key in the upper part of the Touchscreen to select an available Layout. (Layouts are 
listed by their name as shown in the Layouts tab of EuControl software). 

Tracks assigned in the selected Layout appear on their assigned faders. 

3  To exit a Layout, recall the Layout we recommended creating above that stores all fader strips <auto 

assigned>. 

Layouts and Banking/Nudging

Once a Layout is recalled, banking or nudging will only move focus by the number of available 
(<auto assigned>) fader strips. For example, if a Layout includes three tracks assigned to faders 1–3 
on Artist Control, pressing Bank> only banks one fader at a time (since only one fader, number 4, is 
<auto assigned> or “not locked” to a specific track). Note also that it is possible to end up with one 
track appearing on and being controllable by more than one fader strip. In this case, changes made to 
one fader are reflected in the other. 

Track Views for Editing
You can use modifier keys in combination with Artist Series controls to change track views in the Edit 
window. This lets you quickly show waveform data in a track. 

To change a track view to Volume Automation on Artist Mix or Artist Control: 

 Hold Command+Control (Mac) or Start+Ctrl (Windows) and touch the fader for the track SEL key.

To change a track view to Waveform on Artist Mix or Artist Control: 

 Hold Command+Control (Mac) or Start+Ctrl (Windows) and press the track SEL key. 
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Clip Gain
Artist Control includes clip gain commands in its default Touchscreen assignments. These include 
commands to show/hide clip gain and info, and buttons to let you use the jog wheel to raise and lower 
clip gain values. 

Showing and Hiding the Clip Gain Line

To show or hide the clip gain line with Artist Control:

1  From Page 1 (HOME) of the Touchscreen, press CLIP GAIN. 

2  Press Clip Gain Line.

Showing and Hiding Clip Gain Info

To show or hide clip gain info: 

1  From Page 1 (HOME) of the Touchscreen, press CLIP GAIN. 

2  Press Clip Gain Info.

Nudging Clip Gain Up and Down

To increase or decrease clip gain up or down by nudging: 

1  Select one or more clips in the timeline. 

2  From Page 1 (HOME) of the Touchscreen, press CLIP GAIN. 

3  Do the following: 

• To increase clip gain, press the Nudge Clip Gain “up” button. 

• To decrease clip gain, press the lower Nudge Clip Gain “down” button. 

4  Select another clip to adjust by pressing the appropriate button: 

• Press Previous Clip to select he previous clip. 

• Press Next Clip to select the next clip. 

• Press Move Selection Up to select the clip above the currently selected clip. 

• Press Move Selection Down to select the clip below the currently selected clip. 

On Artist Transport you can reassign Soft Keys to provide access to clip gain commands and use the 
wheel to adjust clip gain values. 
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Using the Wheel to Adjust Clip Gain
On Artist Control and Artist Transport you can use the wheel to increase or decrease clip gain. This 
ability is included in the default Appset for Artist Control. 

To increase or decrease clip gain up or down using the wheel: 

1  Select one or more clips in the timeline. 

2  From Page 1 (HOME) of the Touchscreen, press CLIP GAIN. 

3  Press Clip Gain WHEEL. 

4  Turn the wheel clockwise to increase clip gain; turn it counter-clockwise to decrease clip gain. 

Bypassing Clip Gain

To bypass clip gain: 

1  Select one or more clips in the timeline. 

2  From Page 1 (HOME) of the Touchscreen, press CLIP GAIN. 

3  Press Bypass Clip Gain. 

Rendering Clip Gain

To render clip gain: 

1  Select one or more clips in the timeline. 

2  From Page 1 (HOME) of the Touchscreen, press CLIP GAIN. 

3  Press Render Clip Gain. 

Converting and Coalescing Clip Gain
Pro Tools HD (or Pro Tools with Complete Production Toolkit) lets you convert clip gain to volume 
automation, convert volume automation to clip gain, coalesce clip gain to volume automation, or co-
alesce volume automation to clip gain. 

To access Convert and Coalesce commands for clip gain: 

1  Select one or more clips in the timeline. 

2  From Page 1 (HOME) of the Touchscreen, press CLIP GAIN. 

3  Press AUTO. 
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4  Press the corresponding button to do any of the following:
• Convert Clip Gain to Volume Auto

• Convert Volume Auto to Clip Gain

• Coalesce Clip Gain to Volume Auto

• Coalesce Volume Auto to Clip Gain
5  To return to the main CLIP GAIN page, press BACK. 
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Chapter 6: Plug-ins and Sends

This chapter explains how to assign and adjust plug-ins and sends on tracks. 

Working with Plug-in Inserts
This section shows you how to work with plug-ins using Artist Control or Artist Mix. 

Working with Plug-ins on Artist Control

To access and edit a plug-in on Artist Control: 

1  Bank to and select the desired track by pressing its SEL key. 

2  Press the INSERTS encoder. 
If no plug-in is inserted in the current slot, the slot letter appears in lower-case (a, b, c, and so on). 
If any plug-ins are already assigned in the current slot, the name of the plug-in is shown. Plug-in 
names are abbreviated as necessary. For example, if the Compressor/Limiter 3 dynamics plug-in is 
present in the current slot, the display above its track shows CmprsLD.

3  To view other insert slots, press Page> until that slot and any assigned plug-ins are displayed. 

4  Press the encoder for the plug-in you want to edit. 

Soft Encoder for Inserts

SOFT KEYS

HOME

END

Inserts
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The first page of parameters for that plug-in are mapped across the encoders. 

5  Press Page> (or <Page) to access other parameters for the current plug-in. 

Assigning Plug-ins on Artist Control

To assign a plug-in on Artist Control: 

1  Select a track. 

2  Press the Inserts encoder.

3  Press both PAGE keys (<Page and Page>) to enter CONFIG mode. Insert slots are displayed in the 
Touchscreen (a, b, c, and so on), and both PAGE keys flash. 

4  Press the encoder next to the desired insert slot. The Soft Encoders show the next level of choices as 
available on your system (including default EQ or DYN plug-ins if applicable).

5  Press the encoder for the desired insert type. The Soft Encoders show the next level of choices such 
as EQ, Dynamics, Reverb, and so on. (Choices shown on your system will vary depending on which 
plug-ins you have installed, and the Pro Tools setting to organize plug-ins by Category or Manufac-
turer).

6  When the desired plug-in is displayed, press its encoder again to insert it on the selected track. 

Making Plug-ins Inactive or Active on Artist Control

To toggle a plug-in between active and inactive: 

1  Bank to and select the desired track. 

2  Press the Inserts encoder. 

3  Navigate the Touchscreen until the desired insert slot and plug-in name is displayed. 

4  Press a SHIFT key to enable Shift mode (press and release quickly so that both SHIFT key LEDs stay 
lit). 

5  Hold Command+Control (Mac) or Control+Start (Windows) and touch the insert name in the 
Touchscreen. 
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Working with Plug-ins on Artist Mix
This section shows how to use the switches on Artist Mix to access any plug-in inserted on a track. 

To access and edit a plug-in on Artist Mix: 

1  Bank to and select the desired track. 

2  Press the INSERTS key. 
If no plug-in is inserted in the current slot, the slot letter appears in lower-case (a, b, c, and so on). 
Any plug-ins in the current slot are displayed in the track LCD display. Names are abbreviated as nec-
essary. For example, if the Compressor/Limiter 3 dynamics plug-in is present in the current slot, the 
display above its track shows CmprsLD. 

3  To view other insert slots, press Page> until that slot and any assigned plug-ins are displayed. 

4  Press the encoder beneath the displayed name of the plug-in you want to edit. The first page of pa-
rameters for that plug-in are now mapped across the encoders. 

5  Press Page> (or PAGE <) to access other parameters for the current plug-in. 

Assigning Plug-ins on Artist Mix

To assign a plug-in on Artist Mix:

1  Select a track. 

2  Press the INSERTS key. The display shows currently assigned plug-ins (or empty slot letter a–j) 
above the encoders. 

3  Press both PAGE keys (<Page and Page>) simultaneously to enter CONFIG mode. Insert slots for 
the selected track are shown across the display. For example, on a single Artist Mix (eight faders), slots 
a–h are shown; to access additional slots (i and j) press the lit Page> key. 

Artist Mix INSERTS key

SOLOSOLO ON ON SOLOSOLO ON ON SOLOSOLO ON ON SOLOSOLO ON ON
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4  Press the encoder below the slot in which you want to insert a plug-in (such as slot a). The display 
above the first three encoders show the next level of choices as available on your system, including de-
fault EQ or DYN plug-ins, if applicable.

5  Do one of the following: 

• Press the encoder below no insert to leave that slot unassigned. 

• Press multi-channel or multi-mono to see a list of plug-in Categories (such as EQ, Dynamics, and 
other) or Manufacturers. Keep pressing encoders to select the desired Category or Manufacturer 
(plug-in names are shown across the display) and finally the desired plug-in. 

• Press I/O to see available hardware inserts (not available on all systems). Press an encoder to as-
sign that hardware insert.

6  When the desired plug-in is displayed, press its encoder again to insert it on the selected track. 

Making Plug-ins Inactive or Active on Artist Mix

To toggle a plug-in between active and inactive: 

1  Bank to and select the desired track by pressing its SEL key. 

2  Press the INSERTS encoder. 

3  Use the <Page and Page> keys to navigate the display until the desired insert slot and plug-in name 
is shown. 

4  Hold Command+Control (Mac) or Control+Start (Windows) and press the encoder row SEL key for 
the desired plug-in. 
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SEL

ON

SOLOON
For information about automating plug-ins, see Chapter 7, “Automation and Mixing.”



Using the EQ and DYN Keys
You can use the EQ and DYN keys on the Artist Mix an Artist Control to quickly access inserted EQ 
or dynamics plug-ins. 

To access an EQ or dynamics plug-in directly:

1  Bank to display a track with an EQ (or dynamics) plug-in inserted. 

2  Press the EQ (or DYN) key. The display shows the names of any inserted EQ or dynamics plug-ins, 
regardless of their slot location (a–f ). 

3  Press the encoder below the EQ or dynamics plug-in you want to edit. 

EQ/DYN Keys and Standard Plug-in Mapping

When you navigate to an EQ or Dynamics plug-in using the INSERTS key, the parameters are ar-
ranged across your hardware controls in a layout unique to that plug-in, and/or its manufacturer. 

The EQ and DYN keys, by contrast, map the parameters of supported plug-ins according to a standard 
control layout. This lets the controls appear in the same arrangement across your controller, regard-
less of the model or manufacturer. 
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Working with Sends
This section shows how you can assign and adjust Pro Tools sends. 
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Working with Sends on Artist Control

Assigning Sends

To assign sends on Artist Control:

1  Select one or more tracks. 

2  Press the Sends Soft Encoder. The first five Soft Encoders show slots a–e, including any sends al-
ready assigned in that slot. 

Some Artist Series hardware and documentation use the term “AUX” for the Pro Tools term “sends.” 
Do not confuse references to “AUX” with Pro Tools Auxiliary Input tracks. 
3  If desired, press the lit Page> key to go to sends f–j. 

4  Press both PAGE keys (<Page and Page>) simultaneously to enter CONFIG mode. 

5  Press the encoder for the send slot (a–j) you want to assign. The first three Soft Encoders show the 
next choices for Send assignment. 

6  Press a Soft Encoder to choose one of the following: 

no send Assigns no send bus to the selected track(s).

output  Displays available output busses in the Soft Encoders.

bus  Displays available internal busses in the Soft Encoders. 

7  To see additional choices, press the lit <Page or Page> key. 

Soft Encoder for Sends

SOFT KEYS

HOME

END

Sends



8  When the desired output or bus is displayed, press the Soft Encoder for the desired choice. A green 
dot appears indicating that send bus is now assigned to the currently selected tracks. 
Opening and Editing Sends on Artist Control

To access and edit a send on Artist Control:

1  Select a track with send already assigned. 

2  Press the SENDS Soft Encoder. The Soft Encoders show assigned sends, and empty slots (a–e, or 
f–j). 

Once in Aux mode, do any of the following to adjust send parameters: 

To adjust send level:

 Rotate the encoder for the desired send. 

To adjust send pan: 

1  Press the encoder for the send you want to adjust. 

2  Rotate the Soft Knob for L Pan and/or R Pan. 

To mute a send:

 Touch its Soft Encoder in the Touchscreen display (such as Bus 1). Touch again to unmute. 

To toggle the send pre- or post-fader:

 Hold SHIFT and touch the Soft Encoder for the send in the Touchscreen (such as Bus 1). 

Making Sends Inactive or Active on Artist Control

To toggle a send between active and inactive: 

1  Bank to and select the desired track. 

2  Press the SENDS encoder. 

3  Navigate the Touchscreen until the desired send is displayed. 

4  Press a SHIFT key to enable Shift mode (press and release quickly so that both SHIFT key LEDs stay 
lit). 

To assign the send to all selected tracks, hold Option+Shift (Mac) or Alt+Shift (Windows) and press 
the encoder. To assign the send on all tracks, hold Option (Mac) or Alt (Windows). 
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5  Hold Command+Control (Mac) or Control+Start (Windows) and touch the Send name in the Touch-
screen. 
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Working with Sends on Artist Mix

Assigning Sends on Artist Mix

To assign a send on Artist Mix: 

1  Select a track. 

2  Press the AUX key.  

3  Press both PAGE keys (<Page and Page>) to enter Send Assign mode. The display shows the current 
(or last viewed) send slot a–j (an 8-fader system will only show slots a–f ). To see additional send slots, 
press the lit Page> key. 

4  Press the encoder below desired send slot. For example, to assign a send to the current track in slot 
a, press encoder 1. The display above the first three encoders shows the following choices:

To toggle all sends in that same slot (a–j) on all selected tracks, hold Option+Shift (Mac) or Alt+Shift 
(Windows) and touch the Send name. To toggle all sends in that slot on all tracks, hold Option (Mac) 
or Alt (Windows). 
5  Do one of the following: 

• Press the encoder below no send to leave that slot unassigned. 

• Press output to see output bus choices (such as Out 1–2). 

• Press bus to see available internal busses.

6  To see additional choices (beyond the number of faders in your system) press the lit Page> key.

7  When the desired send is displayed, press its encoder to make the assignment. In that fader strip, the 
encoder ON key lights. 

Display no send output bus

Soft Encoder  1  2  3

To assign a send in the same slot to all selected tracks, hold Option+Shift (Mac) or Alt+Shift (Win-
dows) on your computer keyboard while pressing the desired encoder. To assign to all tracks, hold Op-
tion (Mac) or Alt (Windows). 



Opening and Editing Sends on Artist Mix

To access and edit a send (Artist Mix): 

1  Bank to and select the desired track. 

2  Press the AUX key. Send assignments in slot A are displayed in the track LCD display. 

3  To view other sends, press Page> until it is displayed (such as Bus 1–2). 

4  To adjust send level, rotate the encoder directly below the desired send. 
 

To mute the send: 

 Press the ON key in the encoder row directly below the desired send. When muted, the ON key is un-
lit; when the send is on, the ON key is lit. 

To toggle the send between pre- and post-fader: 

 Press the SEL key in the encoder row directly below the desired send. Sends are post-fader by de-
fault, in which state the SEL key is unlit. When the send is pre-fader, the SEL key is lit. 

To adjust send pan: 

1  Press the encoder showing the desired send. If the send is stereo, a single encoder will be mapped 
to send pan (usually encoder 8). If the send is three or more channels (such as LCR, or a 5.1 send), ad-
ditional send pan parameters become available in the encoders (such as divergence, center percentage, 
and other multichannel pan parameters). 

2  Rotate the appropriate encoder. 

Send level encoder on Artist Mix

SEL

ON

SOLOON
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Making Sends Inactive or Active on Artist Mix

To toggle a send between active and inactive: 

1  Bank to and select the desired track. 

2  Press the AUX key. 

3  Use the <Page and Page> keys to navigate the display until the desired send is shown. 

4  Hold Command+Control (Mac) or Control+Start (Windows) and press the encoder row SEL key for 
the desired send. 
 

Encoder SEL key on Artist Mix

SEL

ON

SOLOON
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To toggle all sends in the same slot on all selected tracks, hold Option+Shift (Mac) or Alt+Shift (Win-
dows) and touch the press the encoder SEL key. To toggle all sends in the same slot on all tracks, hold 
Option (Mac) or Alt (Windows) and press the encoder. 



Chapter 7: Automation and Mixing

This chapter shows many of the ways you can control automation settings and how to pan in multi-
channel for surround. Nearly all Pro Tools automation commands and options, including advanced 
features such as Preview and Capture and several Preference settings specific to automation, are 
available through EUCON.

For a complete list of all available commands, see the Pro Tools EUCON Guide. 

For examples of a few of the most common automation workflows, see the following sections. 

• “Enabling and Suspending Automation” on page 65.

• “Selecting Track Automation Modes” on page 66.

• “Advanced Automation Features” on page 67.

• “Shortcuts to Display Automation Playlists” on page 68.

For mixing, see “Multichannel Panning for Surround” on page 74. 

Enabling and Suspending Automation
You can control many Pro Tools automation settings directly from the Touchscreen on Artist Control 
and other units. This section explains how to do so with the default Touchscreen Soft Keys on Artist 
Control. (With Artist Transport, reassign any of its 12 Soft Keys to the commands described below.)

To open the Automation window using Artist Control: 

 In Page 1 (HOME) of the Touchscreen, press AUTO BASIC. 

To enable or disable automation types: 

1  In Page 1 (HOME) of the Touchscreen, press AUTO BASIC. 

2  Press the Touchscreen Soft Key for the desired parameter. For example, to toggle Volume automation 
enabled/suspended, press ENABLE VOLUME. The buttons light when enabled, and goes dim when dis-
abled. 

Keep in mind that some features are only available with Pro Tools HD or Pro Tools with Complete Pro-
duction Toolkit. 
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Selecting Track Automation Modes 
Artist Control and Artist Mix let you put tracks into specific automation modes directly from the 
fader strips. Artist Control also provides Touchscreen Soft Keys for each available mode. 

To select the track Automation mode from the fader strips on Artist Control or Artist Mix:

1  Hold SHIFT while pressing the REC/AUTO key on a track. 

2  Press SHIFT+REC/AUTO again to cycle to the next available automation mode (such as Off, Read, 
Latch, or Touch). 

• To change the automation mode on all tracks, hold Option (Mac) or Alt (Windows) while pressing 
SHIFT+REC/AUTO. 

• To change the automation mode on all selected tracks, hold Option+Shift (Mac) or Alt+Shift 
(Windows) while pressing SHIFT+REC/AUTO. 
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On Artist Control you can also use the Soft Keys Do To All and Do To Selected (see “Do To All and Do 
To Selected” on page 18). 
To select the track Automation mode from the Artist Control Touchscreen:

1  In Page 1 (HOME) of the Touchscreen, press AUTO BASIC. 

2  Press and hold down the button for the desired mode (such as TOUCH), then press any track SEL 
key. 

To select the track Automation mode for all tracks from the Touchscreen: 

1  In Page 1 (HOME) of the Touchscreen, press AUTO BASIC. 

2  Enable the Soft Key for Do To All (it lights when enabled). 

3  Press the Touchscreen button for the desired mode (such as TOUCH). All tracks switch to the se-
lected mode. 

To select the track Automation mode for all selected tracks from the Touchscreen: 

1  In Page 1 (HOME) of the Touchscreen, press AUTO BASIC. 

2  Enable the Soft Key for Do To Sel (it lights when enabled). 

3  Press the Touchscreen button for the desired mode (such as TOUCH). All selected tracks switch to 
the selected mode. 

Punching Out of Automation Recording

To punch out of an automation pass: 

 Press SHIFT+REC/AUTO on the desired track. 



Advanced Automation Features
The AUTO ADV page provides most Pro Tools advanced automation features. This page and its sub-
pages also provide many basic automation commands for convenience. 

To access advanced automation features: 

 In Page 1 (HOME) of the Touchscreen, press AUTO ADV. The AUTO ADV page appears. 

Some of the advanced automation features described here are only available with Pro Tools HD or 
Pro Tools with Complete Production Toolkit. 
The AUTO ADV (Automation Advanced) page is programmed at the factory to provide access to the 
following features (your exact Soft Key assignments may differ). 

• Write to Start, Write to End, and Write to Selection

• Back, Back and Play 

• Write to Punch, Write to Next 

• AutoMatch 

• Join and AutoJoin 

• Preview, Suspend Preview, Punch Preview, Capture, and Punch Capture 

Artist Control Touchscreen showing the AUTO ADV (Advanced Automation) page
The AUTO ADV page also provides buttons for sub-pages with additional automation features. 

AUTO EDIT  Provides commands to cut, copy, and paste, merge, and repeat automation, as well as 
Write to Current, Write to All Enabled, Trim, Glide, thin, and Copy to Send. Press BACK to return to the 
previous page. 

The AutoMatch Soft Key is equivalent to the on-screen AutoMatch button in the Automation window 
(it will automatch all controls). For information on AutoMatching an individual type of automation, 
an individual track, or an individual control, see the Pro Tools Reference Guide. 
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AUTO PREF  Provides access to Pro Tools Preference settings for automation, as well as commands to 
Clear Trim, Coalesce/Convert Clip Gain, and for Trim Playlist and Composite Playlists. Press BACK to re-
turn to the previous page. 

SNAP (Snapshot) Provides available snapshots to select (such as Snap1, Snap 2, and so on). Soft Keys 
at the bottom of the page let you navigate to additional banks of snapshots (such as 13–24, 25–36, and 
so on). Additional commands let you save and clear snapshots, along with Capture, Punch Capture, 
and a button to open the Automation window (Auto Window). Press AUTO ADV to return to the Ad-
vanced Automation page. 

WRITE TO... Provides commands for all Write To commands, along with Preview, Suspend Preview, 

Punch Preview, Capture, and Punch Capture. Press SNAP to go to the Snapshot page; press BACK to re-
turn to the previous page. 

AUTO VIEW Provides commands for changing the type of automation shown in Pro Tools tracks 
(Track View), as well as commands to control whether or not tracks show clip gain (Clip Gain Line 
and Clip Gain Info). 

Shortcuts to Display Automation Playlists 
The following shortcuts let you quickly display the breakpoint automation playlist for a control by 
clicking it in combination with modifier keys on your computer keyboard. These shortcuts work on 
Artist Control and Artist Mix. 

Do to All and Do to Selected

Note that all the following shortcuts can be performed in combination with the Pro Tools keyboard 
shortcuts for Do to All and Do to Selected (also available as Soft Keys). 

To do to all selected tracks: 

 Hold Option+Shift+Control+Command (Mac) or Alt+Shift+Control+Start (Windows) and press 
SEL on any currently selected tracks. 

To do to all tracks: 

 Hold Option+Control+Command (Mac) or Alt+Control+Start (Windows) and press SEL on any 
track.

On Artist Control you can also use the Soft Keys for Do To All and Do To Sel. For more information, 
see “Do To All and Do To Selected” on page 18. 

Artist Control also provides an AUTO VIEW page (HOME > AUTO ADV > AUTO VIEW) with Soft Keys 
to show each type of automation. For more information, see “AUTO VIEW” on page 68.
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Waveform View

To show the waveform for a track in the Edit window:

 Hold Command+Control (Mac) or Control+Start (Windows) and press the track SEL key. 

Track Automation Views

Track Volume

To show volume automation for a track in the Edit window: 

 Hold Control+Command (Mac) or Control+Start (Windows) and touch the track fader. 

Track Pan

To show track pan automation in the Edit window: 

1  Press the PAN key to have pan on the encoders. 

2  Hold Control+Command (Mac) or Ctrl+Start (Windows) and touch the Pan encoder on a track. 

Send Level

To show Send level automation in the Edit window: 

1  Press the AUX key (Artist Mix) or the SENDS Soft Encoder (Artist Control) to bring sends to the en-
coders. 

2  If necessary, press the Page> key until the desired Send slot is displayed. 

3  Hold Control+Command (Mac) or Ctrl+Start (Windows) and touch the Send encoder in the desired 
track. 

Send Pan

To show Send pan automation in the Edit window: 

1  Press the AUX key (Artist Mix) or the SENDS soft Knob (Artist Control) to bring sends to the en-
coders. 

2  If necessary, press the Page> key until the desired send slot is displayed. 

3  Press the encoder for the desired send. 

4  Hold Control+Command (Mac) or Ctrl+Start (Windows) and touch the Send pan encoder on a track. 
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Plug-In Automation

Showing Plug-in Automation

To show automation for a continuous plug-in parameter:

1  Press the INSERTS key (Artist Mix) or the INSERTS Soft Knob (Artist Control). 

2  Display the desired plug-in parameter using the encoders and <PAGE> keys. (See “Working with 
Plug-in Inserts” on page 55.) 

3  Hold Control+Command (Mac) or Ctrl+Start (Windows) and touch the encoder for the desired plug-
in parameter. 

To show automation for a switch-type plug-in parameter on Artist Control: 

1  Press the INSERTS Soft Knob. 

2  Display the desired plug-in parameter using the encoders and <PAGE> keys. (See “Working with 
Plug-ins on Artist Control” on page 55.) 

3  Hold Control+Command (Mac) or Ctrl+Start (Windows) and touch the plug-in parameter in the 
Touchscreen.

To show automation for a switch-type plug-in parameter on Artist Mix: 

1  Press the INSERTS key. 

2  Display the desired plug-in parameter using the encoders and <PAGE> keys. (See “Working with 
Plug-ins on Artist Control” on page 55.) 

3  Hold Control+Command (Mac) or Ctrl+Start (Windows) and touch the encoder.

Enabling All Plug-in Parameters for Automation 

To enable all plug-in controls for automation on Artist Control:

1  Press the INSERTS Soft Knob. 

2  Hold Control+Command+Option (Mac) or Control+Start+Alt (Windows) and touch the desired 
plug-in on the Touchscreen. 
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To enable all plug-in controls for automation on Artist Mix:

1  Press the INSERTS key. 

2  Hold Control+Command+Option (Mac) or Control+Start+Alt (Windows) and press the ON key (in 
the encoder row) for the desired plug-in. 

Pro Tools provides a preference setting for newly inserted plug-ins to default to all parameters en-
abled for automation. This preference setting is available from the Artist Control Touchscreen; from 
the HOME page, press AUTO ADV > AUTO PREF. 



Using VCAs
With Pro Tools HD (or Pro Tools with Complete Production Toolkit), you can add VCA Master tracks 
to your session, show tracks in groups assigned to a VCA, and set Preferences for VCAs.

Creating VCA Master Tracks and Assigning Groups to VCAs

To create a new VCA using the New Tracks command on Artist Control: 

1  In Page 1 (HOME) of the Touchscreen, press NEW TRACKS.

2  In the NEW TRACKS page, press TYPE until the New Tracks dialog shows VCA MASTER. 

3  Configure other settings as desired, then press the OK Soft Key (or click OK on-screen). 

To assign a new group to a VCA Master on Artist Control:

1  Create a new Mix or Mix/Edit group type (see “Working with Track Groups” on page 31). 

2  In the Create Group dialog, use the mouse to choose an available VCA from the VCA pop-up menu. 

Viewing Groups in VCA Masters
You can use Artist Control or Artist Mix to view and adjust tracks in the Group assigned to a VCA. 

Artist Control

To view tracks in a group assigned to a VCA on Artist Control: 

1  Press SEL on the strip for a VCA master that is assigned to a group to select that VCA track. 

2  Press the Mix Encoder. 

3  The Soft Encoders display the members of that group beginning with encoder 1–8. If there are more 
than 8 members in the group, the Page> key lights; press it to show the next members. 

Mix
Only the encoders focus on group members; faders remain focussed on their currently targeted tracks. 
To bank only group members to the faders, use Group Spill (see “Group Spill” on page 35). 
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4  To mute, solo, or adjust level for each member of the group, do the following: 

• To mute a member of the group, touch its Soft Encoder in the Touchscreen. A green indicator be-
low the Soft encoder is lit when the track is unmuted, and off when the track is muted. 

• To solo a member of the group, hold SHIFT and touch its Soft Encoder in the Touchscreen. A yel-
low indicator above the Soft Encoder is list when the track is soloed, and off when it is not. 

• To adjust track level, turn the knob next to its Soft Encoder. 

5  To exit and return the Soft Encoders to their previous view, press the BACK key.

Artist Mix

To view tracks in a group assigned to a VCA on Artist Mix: 

1  Press SEL on the strip for a VCA master that is assigned to a group to select that VCA track.

2  Press CHAN on the left of the Artist Mix to enter Channel mode. 

3  Press SHIFT+PAN/MIX. The display above the knobs shows the members of that group. 
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4  To mute, solo, or adjust level for each member of the group, do the following: 

• To mute a member of the group, press the On button next to its knob. 

• To solo a member of the group, press the Sel button next to its knob. 

• To adjust track level, turn the knob. You can also flip the knobs to the faders by pressing 
SHIFT+CHAN/FLIP in order to adjust level from the faders. 

Only the encoders focus on group members; faders remain focussed on their currently targeted tracks. 
To bank only group members to the faders, use Group Spill (see “Group Spill” on page 35). 
5  To exit, press CHAN. 



Preferences for VCAs and Trim Automation
The following Pro Tools Preferences and command for VCAs and Trim automation are available as 
Soft Keys. These are provided in the default Soft Keys on Artist Control, and are available when reas-
signing Soft Keys on Artist Transport. 

To access Preference settings for VCAs on Artist Control:

1  In Page 1 (HOME) of the Touchscreen, press AUTO ADV, then press AUTO PREF. 

2  Use the available buttons to toggle the following settings on or off: 

• Coalesce when Removing from VCA Group

• Standard VCA Logic for Group Attributes

• Coalesce VCA Automation

• Include Sends in Trim Mode

• Coalesce Trim Automation

• Clear Trim Automation

• Trim Playlist (show the Trim Automation playlist in selected tracks)

For complete information on working with VCAs and using Trim automation, see the Pro Tools Refer-
ence Guide. 
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Multichannel Panning for Surround 
You can use Artist Control or Artist Mix to pan in multichannel for surround sound. 

Surround Panning on Artist Control
In surround sessions, the Touchscreen lets you use the Soft Encoders to pan tracks in surround. 
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To pan in surround using the Soft Encoders:

1  Press a track SEL key to select a track assigned to a multichannel path (such as a 5.1 output bus). 

2  Press the PAN encoder. (If you want to pan a multi-channel send, press the SENDS encoder, then 
press the encoder for the multi-channel send). Multichannel pan parameters such as divergence, pan, 
and center percentage appear in the Soft Encoders. 

3  Press the lit Page> key to show other available pan parameters. 

4  Rotate an encoder to adjust the selected parameter. 

5  To reset a panner to its default position, press the encoder for that parameter. (Be careful with the 
encoder for LFE; pressing it resets LFE send level to unity/0 dB.)

Surround Panning on Artist Mix
Artist Mix lets you use the encoders to control multichannel pan parameters. 

To pan in surround:

1  Press a track SEL key to select a track assigned to a multichannel output path (such as a 5.1 or 7.1 
output path). 

2  Press the PAN key. 

3  Press the CHAN key. Multichannel pan parameters such as Front Left/Right, Front/Rear, divergence, 
pan, and center percentage appear in the Soft Encoders. 

4  Press the lit Page> key to show other available pan parameters. 

5  Rotate an encoder to adjust the selected parameter. 

6  To reset a parameter to its default setting, press the encoder for that parameter. 

The Touchscreen surround panner is not fully supported at this time. Use the encoders instead as de-
scribed below. 

As an alternative to using the encoders, hold SHIFT and press the CHAN/FLIP key to flip pan controls 
to the faders on Artist Mix. Press FLIP again to return to encoders. 

For more information about multichannel mixing, see the Pro Tools Reference Guide. 



Mixdown (Bouncing to Disk and Exporting Tracks)
When you are ready to mix down you can use the default Soft Keys on Artist Control. 

To bounce a mix from the current session: 

1  From Page 1 (HOME) of the Touchscreen, press MENU > FILE > BOUNCE TO... 

2  Do either of the following:

• To bounce to disk, press Bounce to Disc. 

• To bounce to Quicktime, press Bounce to QT Movie.

To export from the current session:

1  From Page 1 (HOME) of the Touchscreen, press MENU > FILE > EXPORT... 

2  Press the corresponding button to do any of the following: 

• Export Sel Tracks as AAF/OMF

• Export MIDI

• Export Sibelius

• Export Session Info as Text

For more information about Pro Tools Bounce to Disk, Bounce to Quicktime, and Export features, see 
the Pro Tools Reference Guide. 

Turning Faders Off
You can “mute” the faders so they do not follow any underlying automation for quieter operation dur-
ing editing or mixdown. This does not affect automation, it merely parks the faders so they do not 
move during playback or Bounce to Disk/Quicktime. 

To turn faders off on Artist Control: 

 From Page 1 (HOME) in the Touchscreen, press AUTO ADV > AUTO PREF > Faders Off. (Repeat to 
turn faders back on.)

It is sometimes helpful to turn the faders off. See “Turning Faders Off” on page 75. 

You can add a new Touchscreen key for Export Selected Tracks as New Session. In the Soft Keys Com-
mand Editor, add a EUCON command and choose File > Export > Export Selected Tracks as New Ses-
sion. For more information, see “Adding a New Touchscreen Soft Key on Artist Control” on page 14. 
– or –
 Hold SHIFT while pressing SOLO in fader strip 1. (Repeat to turn faders back on.)

To turn faders off on Artist Mix: 

 Hold SHIFT while pressing SOLO in fader strip 1. (Repeat to turn faders back on.)
Chapter 7: Automation and Mixing 75



76
 Artist Series and Pro Tools Guide



Numerics
9-Pin Remote 40

A
Abort Record 40
active and inactive tracks 30
active/inactive

plug-ins 58
plug-ins Artist Control 56
sends 61
sends, Artist Mix 64

Artist Control
input and output routing 26
plug-ins 55

Artist Mix
input and output routing 29
plug-ins 57

Artist Transport 11
markers 46

Auto Ins Punch 40
AUTO PREF 68
AutoJoin 67
AutoMatch 67
automation 66

Clear Trim 68
Clear Trim Automation 73
Coalesce Trim Automation 73
Composite Playlist 68
cut, copy, paste, clear 67
glide 67
Include Sends in Trim Mode 73
merge 67
plug-ins 70
preferences for 68
Repeat to Fill 67
shortcuts to show playlist 68
thin 67
track view 68
trim 67
Trim Playlist 68, 73
Write to All Enabled 67
Write to Current 67

Avid
customer success 3

B
Back, Back and Play 67
Bank/Nudge 22
banking 22
Bars|Beats 42
Bounce to Disk 75
Bounce to Quicktime 75

C
Capture 67
Clear Trim Automation 73
Click 39
clip gain 51

adjust with the wheel 52
Bypass 52
Clip Gain Info 51
Clip Gain Line 51
coalesce 52
convert 52
nudging 51
Render 52

Clip Groups 42
Coalesce Trim Automation 73
Coalesce VCA Automation 73
Coalesce when Removing from VCA Group 73
compatibility 1
Composite Playlist 68
Copy 42
Count Off 39
Counter 42
customize (remap with EuControl) 10
Cut 42
Index
Index 77



78
D
DestructivePunch 39
Dynamic Transport 39

E
Edit Lock/Unlock 42
Edit Modes 44
Edit/Tool Mode Keyboard Lock 44
editing

Smart tool 43
Enable Tab to Transients 40
encoders 23
EUCON 1
EuControl

customizing 10
EuControl Settings window 10
Export MIDI 75
Export Selected Tracks as AAF/OMF 75
Export Session Info as Text 75
Export Sibelius 75
Extend Selection 42

F
fader 23
fades 42
Fast Forward 20
feetframes 42

G
Glide 67
Go to End of Session 40
Go to Song Start 40
Grid (rel and ab) 44
Grid value 42
Group (clips) 42
groups 31

Group Spill 35

H
Half-Speed Play 39
Half-Speed Record 40
home (bank) 22

I
ICON 6
Include Sends in Trim Mode 73
input 26, 29
Insert Assembly 40
Artist Series and Pro Tools Guide
J
Jog 44
Join 67

L
Link Timeline/Edit Selection 42
Link Track/Edit Selection 42
Loop (clips) 42
Loop Record 38, 40
Low Latency Monitoring 40

M
make active/inactive

plug-ins (Artist Mix) 58
Mark In and Out 42
Markers 46
Master Input Monitor (Input Only Mode) 39
Master Record 39
memory locations (see Markers)
MIDI and EUCON 6
MIDI Merge 39
minsec 42
Move Selection 42
Mute and Unmute Clip 42

N
Next 40
Next Record Mode 39
Nudge value 42

O
output 26, 29

P
pan 23

stereo tracks 23
Paste 42
Pause 39
Play 20
Play/Stop 39
plug-ins

assigning 56, 57
make active/inactive (Artist Control) 56

Post-Roll 39
Pre-Roll 39
Prev 40
Preview 67
Punch Capture 67



Punch Preview 67

Q
QuickPunch 38

R
Record (Transport) 20
recording 37

abort 40
DestructivePunch 39
half-speed record 40
loop recording 40
low latency monitoring 40
modes 38
TrackPunch 38

Restore Last Selection 42
Rewind 20
RTZ3 20

S
samples 42
Satellite 40
Scroll to Track 31
SEL (Assign) 25
selecting tracks 25
sends 63

assigning 60, 62
level, pan, mute, pre/post 61

Separate 42
Separate Clip 42
Set Record Tracks to Input Only (Master Input 

Monitor) 39
SHOW 11
showing and hiding tracks 30
Shuffle 44
Shuttle 44
Slip 44
Smart tool 43
snapshots 68
Spot 44
Standard VCA Logic for Group Attributes 73
stereo pan 23
Stop 20
Suspend Preview 67
Sync Point 42
system requirements 1
T
Tab to Transients 40
technical support 3
time code 42
Toggle Transport Master 40
track height 45
Track View 68
TrackPunch 38
tracks

active and inactive 30
banking 22
home 22
selecting 25
show/hide 30

Trim Clip 42
Trim Lock/Unlock 42
Trim Playlist 68, 73

U
Undo 42

V
VCAs 71

Coalesce VCA Automation 73
Coalesce when Removing from VCA Group 73
creating 71
Standard VCA Logic for Group Attributes 73
viewing members of (spill) 71

Video Out Firewire 40
Video Out PCIe 40
Video Track Online 40
volume (fader) 23

W
Wait for Note 39
windows

toggle Mix and Edit window views 48
Window Configurations 48

Write to All Enabled 67
Write to Current 67
Write to Next 67
Write to Punch 67
Write to Start, End, Selection 67

Z
Zoom Toggle 42
zoom using the Jog wheel 45
Index 79



Avid
2001 Junipero Serra Boulevard 
Daly City, CA 94014-3886 USA
Technical Support (USA)
Visit the Online Support Center at 
www.avid.com/support
Product Information
For company and product information, 
visit us on the web at www.avid.com


	Contents
	Chapter 1: Introduction
	System Requirements and Compatibility
	About This Guide
	Conventions Used in This Guide

	About www.avid.com

	Chapter 2: Software Configuration
	Enabling EUCON in Pro Tools
	Confirm Installation


	Chapter 3: Basics
	EuControl Basics
	Viewing EuControl Settings On-Screen
	Customizing a Soft Key on Artist Transport
	Adding a New Touchscreen Soft Key on Artist Control

	Do To All and Do To Selected
	Soft Keys for Do To All and Do To Selected

	Using the Transport
	Using the Transport Controls

	Banking Faders
	Fader Strip Controls
	Adjusting Track Volume and Pan
	Flipping Encoder Parameters to Faders on Artist Mix (Only)

	Track Basics
	Selecting Tracks
	Track Input and Output Routing
	Showing and Hiding Tracks

	Working with Track Groups
	Working with Track Groups on Artist Control
	Working with Track Groups on Artist Mix


	Chapter 4: Recording
	Select and Record Enable Tracks
	Loop Record, Quick Punch, and Other Record Modes
	TrackPunch
	DestructivePunch

	Additional Recording Features

	Chapter 5: Editing
	Overview of Editing
	Selecting Edit Tools and Edit Modes
	Edit/Tool Mode Lock

	Using the Jog/Shuttle Wheel
	Jog and Shuttle
	Zoom Horizontally
	Zoom Verticaly (Adjust Track Height)
	Marking and Moving Selections

	Using Markers (Memory Locations)
	Using Markers on Artist Transport
	Using Markers on Artist Control
	Working with Windows and Window Configurations

	Recalling Layouts
	Track Views for Editing
	Clip Gain
	Showing and Hiding the Clip Gain Line
	Showing and Hiding Clip Gain Info
	Nudging Clip Gain Up and Down
	Using the Wheel to Adjust Clip Gain
	Bypassing Clip Gain
	Rendering Clip Gain
	Converting and Coalescing Clip Gain


	Chapter 6: Plug-ins and Sends
	Working with Plug-in Inserts
	Working with Plug-ins on Artist Control
	Working with Plug-ins on Artist Mix
	Using the EQ and DYN Keys

	Working with Sends
	Working with Sends on Artist Control
	Working with Sends on Artist Mix


	Chapter 7: Automation and Mixing
	Enabling and Suspending Automation
	Selecting Track Automation Modes
	Advanced Automation Features
	Shortcuts to Display Automation Playlists
	Using VCAs
	Creating VCA Master Tracks and Assigning Groups to VCAs
	Viewing Groups in VCA Masters
	Preferences for VCAs and Trim Automation

	Multichannel Panning for Surround
	Surround Panning on Artist Control
	Surround Panning on Artist Mix
	Mixdown (Bouncing to Disk and Exporting Tracks)
	Turning Faders Off


	Index

